Hey! Beijing: China Special Series: Promoting the Internet Travel Program of Beijing with Motion Graphics

Pengxiao Zhao

Follow this and additional works at: http://scholarworks.rit.edu/theses

Recommended Citation

This Thesis is brought to you for free and open access by the Thesis/Dissertation Collections at RIT Scholar Works. It has been accepted for inclusion in Theses by an authorized administrator of RIT Scholar Works. For more information, please contact rtscholarworks@rit.edu.
HEY! BEIJING

China Special Series: Promoting the Internet Travel Program of Beijing with Motion Graphics

Pengxiao Zhao
MFA Candidate

Computer Graphics Design Program
School of Design
College of Imaging Arts and Sciences
Rochester Institute of Technology
November 2012
<table>
<thead>
<tr>
<th>Role</th>
<th>Name</th>
<th>Title</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chief Adviser</td>
<td>Dan DeLuna</td>
<td>Associate Professor, Computer Graphic Design</td>
<td></td>
</tr>
<tr>
<td>Associate Adviser</td>
<td>Chris Jackson</td>
<td>Associate Professor, Computer Graphics Design</td>
<td></td>
</tr>
<tr>
<td>Associate Adviser</td>
<td>Shaun Foster</td>
<td>Assistant Professor, Computer Graphics Design</td>
<td></td>
</tr>
<tr>
<td>Chairperson</td>
<td>Peter Byrne</td>
<td>Associate Professor, School of Design</td>
<td></td>
</tr>
<tr>
<td>MFA Candidate</td>
<td>Pengxiao Zhao</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
00 ABSTRACT

01 INTRODUCTION
1.1 Problem Statement
1.2 Target Audience

02 SURVEY OF THE LITERATURE

03 PROCESS
3.1 Concept
3.2 Timeline
3.3 Software
3.4 Sketches
3.5 Modeling
3.6 Main Character Design
3.7 Scene Design
3.8 Texture
3.9 Animation
3.10 Framing
3.11 Typography
3.12 Rendering and Compositing
3.13 Points to Note

04 CONCLUSION
4.1 Feedbacks
4.2 Thesis Summary

05 BIBLIOGRAPHY

06 APPENDIX: THESIS PROPOSAL
00/
ABSTRACT
Beijing, the capital of China, is considered one of the largest cultural centers in the world. Because of its mysteries and long historical heritages, visitors from all over the world love to travel and witness such a miraculous city. Thus, an Internet travel program featuring Beijing is the primary goal to introduce China to the world. Audiences, especially travelers, will always enjoy watching a high-quality Internet travel channel with a stylish, yet informative, title sequence. As a result, this thesis project aims to use a new computer graphic design technique to create and promote the original title sequences.

For the title sequence, I design a fictitious Internet travel program called Hey! Beijing. The elements primarily include various famous architectures from not only the historical side but also from a brand new cutting-edge perspective. The duration of the animation will be one minute forty seconds in length.
INTRODUCTION

1.1 Problem Statement

1.2 Target Audience
1.1 PROBLEM STATEMENT

The traditional ways of title sequences for Internet travel programs in China have always been limited to the techniques of 2D photographs and documentaries. Thus, as an important travel guide, how can computer graphic design promote an international and innovative title sequence that can create a new way to attract a global audience?

We live in an age and society in which our expectations are continually heightened by innovations in technology. People are more responsive to visually-satisfying and appealing aesthetics in a promotional piece. Personally, I feel motion graphics, animation design, and 3D modeling can change the response. Using these styles and new computer graphic skills of promoting China through Beijing will give tourists a perspective that differs from traditional ways. I feel that people will be more intrigued and entertained about China’s many traditional elements. By using new computer graphic design skills to attract people to the country, people will have a more new-age, modern feel that will be more appropriate and current for the times in which we live. It will not feel outdated through the use of previous common methods used for tourist promotions.

In order to solve this problem, I will design a title sequence that combines Chinese traditional features with advanced techniques that I have learned during my program. I will create this motion piece with some 2D animation background layers to add visual effects. Additionally, 3D modeling layers will represent some traditional Chinese elements through the use of paper-cutting shapes, as well as a moving pop-up-book-style animation. These new media methods will enhance the visual aesthetics of title sequences of traveling programs.
1.2 TARGET AUDIENCE

The target audience of this travel program will be individuals between ages 15-70 who love embarking on new adventures and are interested in Chinese culture.
SURVEY OF THE LITERATURE
Research for this thesis involved an investigation into different books, articles, and websites that were written on the subject of title sequence, motion graphics, paper-cutting design, and architecture design.

The book Unfolded Paper in Design, Art, Architecture and Industry (Petra Schmidt / Nicola Stattmann, 2009) showcases creative uses of paper with helpful descriptions about each project by professionals in various fields. In addition, the book Paper Cutting (Laura Heyenga, 2011) collects many excellent examples of the variety of cut-paper artists. Closeups of artwork along with brief descriptions make the techniques comprehensive, beautiful reproductions. These books gave me inspiration to create a title sequence using a paper-cutting style.

The books Impeccable Scene Design for Game, Animation and Film (Weiye Yin, 2011) and Proto Anime Cut Archive (Stefan Riekeles, 2011) gave me a number of ideas in 3D architecture design, scene design, and background / texture design. The books Mastering Maya 2009 (Micheal Ingrassia, 2008), Flash+After Effect: Add Broadcast Features to Your Flash Designs (Chris Jackson, 2010), and Advanced Maya Texturing and Lighting (Lee Lanier, 2008) gave me technical knowledge in Maya and Motion Graphics. All of these works are incorporated into this thesis.
03/ PROCESS

3.1 Concept
3.2 Timeline
3.3 Software
3.4 Sketches
3.5 Modeling
3.6 Main Character Design
3.7 Scene Design
3.8 Texture
3.9 Animation
3.10 Framing
3.11 Typography
3.12 Rendering and Compositing
3.13 Points to Note
3.1 CONCEPT

There are three sections to this thesis project: old Beijing, the transition section, and a more modern Beijing. In this video I created a typical Beijing taxi that drives through all the scenes in transition between old Beijing and modern Beijing in the form of paper-cutting shapes. I use Maya® to animate the unfolding pages. For the old Beijing section, I created the most famous traditional architectures of Beijing to represent this traditional city (such as the Great Wall, the Forbidden City, Summer Palace, and Tiananmen Square). Within the transition section, I use classical architecture styles for residential housing in old Beijing to serve as a time gate connecting old Beijing with modern Beijing. To represent the new Beijing section, I use some modern, innovative architectures such as the New CCTV building, Bird Nest, National Grand Theater, Water Cube, and Terminal Three Airport.
3.2 TIMELINE

The progress of my work has been in two stages from summer 2011 to spring 2012, as shown below:

- **Summer, 2011**
  Research References > 1st edition Storyboard > 1st edition Modeling

- **Fall, 2011 (Revision period)**
  2nd edition Storyboard > 2nd edition Modeling

- **Winter, 2012**
  Modeling > Texturing > Lighting > Animating

- **Spring, 2012**
  Animating > Rendering > Compositing > Defense > Thesis show
3.3 SOFTWARE

I utilized four types of software to create this thesis project: Adobe Illustrator, Adobe Photoshop, Autodesk Maya, and Adobe AfterEffect. Adobe Illustrator was key for simplifying and sketching the traditional Chinese architecture elements in the paper-cutting style and also in designing the logo of this fictitious Internet travel program. Adobe Photoshop was used for making storyboard and hand-drawing style texture of each element. Autodesk Maya was utilized for modeling, lighting, rendering, and animation. Adobe AfterEffect was used for compositing and some special effects.
3.4 SKETCHES

Ancient Chinese architecture has a long history, as well as being an important component of the world architectural system. The most significant characteristic is the use of timber framework. The decorative paintings and the complex carvings, compared to the traditional architecture, make it more unique, beautiful, and engaging. Therefore, it becomes quite a challenge to fully represent this kind of magnificent and complex architecture.

The sketches for this project were based on the paper-cutting style that was inspired by traditional Chinese paper cutting. After experimenting with different combinations of the paper-cutting and traditional architectural styles, I modified and simplified the shape of Chinese architecture structures but did not erase the unique characteristics. Eventually, the style turned them into paper-like texture. In the below sketches, I mainly focused on the style of sketch, the hardest part of the traditional architecture, in order to conform to the main style of this project. Moreover, I sketched the referred elements, such as passenger, cloud, ornamental columns, trees, and fence, in order to import the Illustrator object into Autodesk Maya to achieve a planar-curve-shape object as the element. (See Fig.1, Fig.2)
Fig. 1 Sketches of QianMen Street, Tiananmen Square, and Temple of Heaven
Fig. 2 Sketches of Forbidden City, Summer Palace, and Old Summer Palace
3.5 MODELING

Initially, I had attempted modeling with two different methods before confirming the final look in Maya. One modeling method that I looked into was the one-piece paper-cutting style, which was implemented by using the above AI vectors that had been created earlier in the Sketches Phase to import into Maya by Adobe® Illustrator Object; however, the result came out in a bold and cursory way. So I decided to use another modeling method, the paper-box style, to avoid the initial problems and to make the model more subtle and detailed. Based on the shape of building vectors I made, I used some basic techniques to Extrude and Merge Vertex/Edge to create the final modeling, while still keeping it simple and clean. To mitigate any rendering issues, the surface of each plane on the paper-box shape element is minimal. The detailed part on the surface will subsequently be showcased during the Texture Phase. (See Fig.3, Fig.4)
Fig. 3 One-Piece Paper-Cutting Style

Fig. 4 Paper Box Style
3.6 MAIN CHARACTER DESIGN

In this thesis project, I created a typical Beijing taxi that would travel through all the scenes while moving through old Beijing into modern Beijing in the form of paper-cutting shapes. The Beijing taxi, which in here is considered “the city name card,” offers the most direct description to get a feel for the whole city. Moreover, as for tourists, taxis are probably the most popular vehicle to get around the city itself. I choose the Beijing taxi as the most suitable character that passes by all the scenes to fully represent Beijing and allows the taxi driver, along with his/her warm personality, to be an excellent tour guide to present and reveal the rich culture of the city. (See Fig.5)

Fig.5 Rendering of Beijing Taxi
3.7 SCENE DESIGN (In order of appearance)

3.7.1 THE OLD BEIJING SECTION

Qianmen Street

In this thesis project, I created a typical Beijing taxi that would travel through all the scenes while moving through old Beijing into modern Beijing in the form of paper-cutting shapes. The Beijing taxi, which in here is considered “the city name card,” offers the most direct description to get a feel for the whole city. Moreover, as for tourists, taxis are probably the most popular vehicle to get around the city itself. I choose the Beijing taxi as the most suitable character that passes by all the scenes to fully represent Beijing and allows the taxi driver, along with his/her warm personality, to be an excellent tour guide to present and reveal the rich culture of the city. (See Fig.6)

Fig.6 Rendering of Qianmen Street
Tiananmen Square

Tiananmen Square, located in the center of Beijing, is the third largest city square in the world. It is also a gathering place for political and cultural events where Chairman Mao announced the establishment of the People’s Republic of China in 1949. Tiananmen Square contains the monument to the heroes of the revolution, the National Museum of China, the Great Hall of the People, and the Chairman Mao Memorial Hall. (See Fig.7)

Fig.7 Rendering of Tiananmen Square
Forbidden City

The Forbidden City is located directly to the north of Tiananmen Square. It is the imperial palace where 24 emperors ascended the throne and exercised their power to the nation during the mid- to later- Ming and Qing dynasties. The Forbidden City also provides outstanding examples of the greatest palatial architectural ensembles in China, so it becomes China’s most attractive and fascinating tourist destination. (See Fig.8)

Fig.8 Rendering of Forbidden City
Temple of Heaven

Temple of Heaven in southern Beijing is China’s largest existing complex of ancient sacrificial architecture and I have always considered such as “a masterpiece of architecture and landscape design.” It used to be the location where the emperors held the Heaven Worship Ceremony and prayed for a good harvest. (See Fig.9)

Fig.9 Rendering of Temple of Heaven
Summer Palace

Summer Palace is northwest of Beijing and is the largest and best-preserved royal garden in China. It influences Chinese horticulture and landscape with its famous natural views and cultural interests. Royal members used to reside in the Summer Palace during summer for vacations and other recreational purposes. It virtually features traditional Chinese garden art that blends rocks, lakes, trees, pavilions, and path to create a poetic effect between each scene. (See Fig.10)

Fig.10 Rendering of Summer Palace
Old Summer Palace

Old Summer Palace is one of the most magnificent gardens in China’s history. It used to exhibit a fantasy land of ponds, ancient trees, hills, lakes, and some palaces filled with centuries-old royal treasure collections. However, Old Summer Palace was destroyed once by British and French troops during the Second Opium War and again by the eight allied foreign forces in 1900. Today it has been reconstructed, and the ruins have become one of the famous historic spots, serving as living proof of history. (See Fig.11)

Fig.11 Rendering of Old Summer Palace
The Great Wall

One of the greatest wonders and sights of the world, The United Nations Educational, Scientific and Cultural Organization (UNESCO) listed the Great Wall as a World Heritage. As the longest man made wall in the world, The Great Wall is an awe-inspiring feat of ancient defensive architecture. It is a miracle in history, along with its longest construction duration and greatest cost in human lives, blood, sweat, and tears. Also, the scenery along with the Great Wall is like a dragon across desert, grasslands, mountains, and plateaus. The famous quote by Chairman Mao was “Until you reach the Great Wall, you’re no hero!” (See Fig.12)

Fig.12 Rendering of the Great Wall
3.7.2 THE TRANSITION SECTION

Hu Tong

Hu Tong is a lane or alley formed by a row of courtyard where old Beijing residents lived. In Beijingers’ eyes, Hu Tong represents a long array of history, a cordial lifestyle, and even a cyclopedia of Beijing. In the past, each Hu Tong was originated from a composition of hundreds of courtyards, but a vast amount of them have fallen dramatically into disrepair and do not meet current city requirements. Thus, protecting the remains of Hu Tong is an urgent problem for modern people. (See Fig.13)

Fig.13 Rendering of Hu Tong
3.7.3 THE MODERN BEIJING SECTION

Terminal 3 of Beijing Capital Airport

Terminal 3 is the second largest airport terminal in the world. It has established itself as a modern cultural symbol that combines functional aspects with aesthetic architectural design. The arch of the massive roof of terminal 3 is decorated with triangular skylights, which from the outside look like the scales of a dragon. Deep red pillars are also reminiscent of the old imperial Beijing. (See Fig.14)

Fig.14 Rendering of Terminal 3 of Beijing Capital Airport
Beijing West Railway Station

Beijing West Railway Station is the latest structure in Beijing and the largest in Asia at the present time. The entire building is designed in the form of a Chinese character 品. Construction of this station has not only greatly relieved the transportation congestion in Beijing but also plays an important role in the complex rail networks in the capital. (See Fig.15)

Fig.15 Rendering of Beijing West Railway Station
Chang’An Avenue

As China’s best-known street, which used to be the main road into the imperial City (Forbidden City) in ancient China, Chang’An Avenue runs from east to west in the city. There are many important buildings and commercial district on its route, such as Tiananmen Square, National Grand Theater of China, Beijing international Hotel, Henderson Center, Ocean Plaza, Headquarter Building of the Bank of China, Wangfujing Commercial Street, China World Trade Center, and many more landmarks. (See Fig.16)

Fig.16 Rendering of Chang’An Avenue
China World Trade Center, SOHO New Town, and CCTV Headquarters

These three architectural complexes are located in the central business district of Beijing. China World Trade Center is the largest building complex in Beijing and is well known for being the largest up-market commercial mixed-use development in the world. SOHO New Town is a brilliant work of art in the central business district and boasts a collection of contemporary Chinese art. CCTV Headquarters is the most remarkable building in China’s new architecture; it not only represents the new image of Beijing but also expresses the importance of the TV industry. (See Fig.17)

Fig.17 Rendering of China World Trade Center
Linked Hybrid - Beijing MOMA

Beijing Linked Hybrid (Beijing MOMA) is a model for future large-scale, sustainable residential building complexes. This futuristic residential complex includes eight towers that are linked by a ring of eight air corridors housing a variety of public functions. It opens to the public from every side of the construction, forming an impressive, new-century, porous urban space. (See Fig.18)

Fig.18 Rendering of Beijing MOMA
Beijing Olympic Stadiums

The main stadiums of the 2008 Beijing Olympic Games are well known as Bird Nest (National Stadium) and Water Cube (National Aquatics Center). Bird Nest was not only designed for Olympic events of track and field, football, and weight throw but also held the opening / closing ceremonies as well as other important events. Water Cube, which is located next to Bird Nest, was first built as the main natatorium for the Beijing 2008 Olympic Games. In addition, some featured stadiums and buildings are represented in this scene, such as Basketball Gymnasium, Shooting Range Hall, and Pan Gu Plaza. (See Fig.19)

Fig.19 Rendering of Beijing Olympic Stadiums
3.8 TEXTURE

As for the texture aspects, I created three different texture styles: One Color, Color Combination, and Hand-Drawing Sketch. After texture testing, the first two styles were found to be more monotonous and duller and lacked layers. In contrast, the hand-drawing sketch is more exquisite and stylish. Moreover, as the long history of Beijing features, I decided to use the hand-drawing style as the best texture to represent these traditional architectures in this video.

After using Extrude Face / Edge Tool and Merge Vertex / Edge Tool to complete the numerous models, the Extract Tool was used for splitting each object into individual pieces, making it easier to create textures on each surface.

First I chose Lambert in the HyperShade window, which is similar to the paper material, and this served as the material for all of the objects. I then proceeded to use Planar Mapping, which is under Polygons Mode, to see the appearance of the projection on UV Mapping, and I repeated this same method for each surface of every object. After completing the individual surface-planar mapping of an entire architecture, I used UV Texture Editor to collect and tile all of the projection surfaces and then resized or repositioned them to make the map editable in Photoshop. Next, I used UV Snapshot to save the completed texture as a PNG format picture, allowing for the objects to be edited and hand drawn in Photoshop. Lastly, I assigned the Lambert material to the object and applied the final hand-drawing texture. (See Fig.20, Fig.21A, Fig.21B)
Fig. 20 Texture Testing

Fig. 21A UV mapping of Tiananmen
The remaining planar elements, such as passengers, street lamp, trees, and clouds, were created in AI, and Adobe® Illustrator Object was used to import the AI curve into Maya. The Planar Tool, which is located under Surface Mode, fulfilled the transformation from curve to the polygon plane. The same approach was used for the texture mapping in Maya. (See Fig.22, Fig.23A, Fig.23B)
Fig. 22 Settings of Planar Tool

Fig. 23A UV mapping of Memorial Archway
Fig. 23B UV mapping of Memorial Archway
3.9 ANIMATION

This thesis is based on the paper-cutting style; hence I used a pop-up style to animate all the architecture and elements. First I used the Extract Tool, which is under Polygons Mode, to split all the surfaces of all the architectures into separate objects. Second I entered button P to set the Parent Constraint to the animation layers (e.g., roof part, side surfaces, and front surfaces). I parented the roof part and side surfaces to the front surface of each building. Then the Rotation Tool was used for animating the pop-up effect and unfolding animation. Once the taxi passed by each building in each scene, the parented polygon planes would rotate up as an unfolding box to establish a completed architecture. (See Fig.24)

Fig.24 Utilization of Rotation Tool
Moreover, I made a continuously lengthening road, and it moved along with the taxi in the video. For instance, in the first scene, where the taxi and many ribbons popped out from the opening box, I used Attach Brush To Curves (Paint Effect > Curve Utilities, Rendering Mode) to draw a paint effect on the prepared CV Curve. Eventually, I used Attribute Editor to adjust each value in order to reach the effect and shape of ribbon. In the Attribute Editor, under the StrokeShape tab, Sample Density is used to make the curve path smoother, and Min Clip and Max Clip (End Bounds) are to control the growing animation by setting key frames between values 0 and 1. Under the Brush tab, Brush Width is to modify the width of the ribbon; Flatness1 is to flatten the hollow-empty ribbon to flat. After completing the edit of the ribbon, make sure to convert Paint Effect Stroke to Polygonal Meshes (Modify > Convert > Paint Effects to Polygons). (See Fig.25, Fig.26)

Fig.25 Utilization of Paint Effect Tool
I used the Motion Path Tool, which is under Animation Mode, to animate the driving taxi to pass through scene by scene. However, before using the Attach to Motion Path tool (Animate > Motion Paths) to bind the grouped taxi to the curve path (driving direction), I made sure the pivot points of the taxi and curve path are center aligned (Modify > Center Pivot). In addition, the direction of the headstock has to be consistent with X-axis direction in order to make sure the car will drive forward but not backward. After rotating the headstock to the correct driving direction, Freeze is used for all the transformations in Layer Editor in order to freeze the Normal on the polygonal taxi and reset the new position. Then, according to the specific time for each shot in different scenes, adjust U Value of each motion path to specify the start frame/time and end frame/time of the motion path animation in time range. For the taxi, I grouped the whole car and used Post Infinity (Cycle), which is in Graph Editor, to loop the rotation animation of the four wheels, allowing the taxi to drive smoothly and realistically on the road. (See Fig.27, Fig.28)
Fig. 27 Values after Freeze All

Fig. 28 Utilization of Motion Path Tool
3.10 FRAMING

In camera framing, I used a different camera shot for each scene through the title sequence. The motion started from a static panoramic shot to show the main character—the Beijing taxi driving out of a paper box along with hundreds of ribbons. On the camera movement, I zoomed in, followed, paned, and tilted the camera through the animation. I think the best shot in this project is the camera following the back of the taxi driving forward to the gate when that scene suddenly changes to a completely new scene—modern Beijing—along with opening the air-filled clouds layer by layer. The background soundtrack changes as well. It can provide a totally refreshing feeling to the audience.
3.11 TYPOGRAPHY

For the logo of this fictitious Internet travel program, Hey! Beijing, I have used both English and Chinese words. The reason for having a mix of characters is that this program can serve as a bridge or connection between Eastern and Western cultures. The audience will get a warm welcome with something that they are familiar with and that will also allow the audience to be curious as to the exact meaning and hopefully increase their desire to learn even more. For the Chinese character and the graphic itself, I used a traditional Chinese writing brush and a classic Chinese pattern. I chose the Helvetica font for the English subtitles. I also adjusted the kerning of the B and e to justify the word’s alignment (Beijing in English) in a better order to closely fit the Chinese version. It looks more balanced and appropriate on the screen. (See Fig.29, Fig.30)

Fig.29 Logo testing
Fig. 30 Bilingual Logo

Beijing Online Traveling Channel
3.12 RENDERING AND COMPOSITING

As for the rendering aspects, I created two different render styles: Physical Sun and Sky and Ambient Occlusion. The combination of both Physical Sun and Sky and Ambient Occlusion looks more physically accurate and subtle. Before using the Physical Sun and Sky system, I made sure to set the Render setting to Mental Ray. (If the Mental Ray option isn’t shown in the drop-down menu, go to: Window > Settings/Preferences > Plug-in Manager and make sure the check-boxes for Mayatomr.mll are checked.) I rotated the directional light, which is supposed to be the sunrays, down to 45 degrees to change the time to the dusk intensity, which looks more yellow and offers a warmer feeling. Then I adjusted the shading setting to get the result that I expected. In addition, I linked the Physical Sky environment to the camera for each shot. The dusk intensity of the environment plus the hand-drawing texture gives the audience a proper feeling of atmosphere for the traditional historical city, which is more appropriate to the theme of the Beijing online traveling channel. In addition, the use of the Ambient Occlusion Pass makes the 3D object more realistic by creating a soft shadow on it.

For compositing, I composed the Ambient Occlusion Pass in Multiply mode, whereas I generated the rendering sequences by the Physical Sun and Sky all together in Adobe AfterEffects. Then I used the Color Correction tool to tweak the color tone and saturation and Glow Effect to make the scene look more elegant and glorious. Lastly, I used Motion Blur to make the animation look smoother. (See Fig.31-Fig.34)
Fig. 31 Physical Sun and Sky Attribute Editor Setting
Fig. 32 Render Setting 1
Fig. 33 Render Setting 2
Fig. 34 Compositing

- Ambient Occlusion Pass in Multiply Mode
- UV Mapping
- Physical Sun and Sky System
- Final Compositing (Motion Blur/Glow/Color Edit)
3.13 POINTS TO NOTE

Once I achieved my final style and was ready for animating, there were some adjustments and considerations I had to pay attention to.

For the timing control, I chose a simple way that equally distributed 7 seconds to each scene respectively; it was 1’42’ in total as my thesis was consisted of 16 scenes. Depending on how many objects to show in each scene, The more the objects, the longer the time needs. However, total cannot be longer than 15 seconds or less than 5 seconds. Also, I would have to replay the preview animation in Maya prior to further rendering, and which was easier for me to increase or decrease frame in order to control the timing. However, I still needed to re-render even though I might have prepared well before starting rendering as the rendered sequences were unsatisfied. For instance, when I started compositing and putting all the rendering scenes together in After Effect, I found the speed of the car moving through each scene was not the same, so what I did was changing the start and end frames of motion path on timeline to test the questionable scene repeatedly until succeeded and re-rendered them.

For the camera movement, I chose to set up the individual camera and drew the specific movement path for each shot. It was easier for me to revise the movement graph of camera if I had to re-render some sequence.

For rendering result, if I was only required to revise rendering style, the Physical Sun and Sky were actually simple to modify as the visual style was directly indicated by changing its settings.
04/ CONCLUSION

4.1 Feedbacks

4.2 Thesis Summary
4.1 FEEDBACKS

After demonstrating my thesis to people, both positive and negative results were received.

**Strength:** 1) Really good at cinematography in each scene, the movements of camera are smooth. 2) Pretty rendering style, the light warm yellow tone of the entire background does match with the traditional historical background of Beijing. 3) Hand-drawing texture style is quite fresh, eye-catching and outstanding, also seems subtle on the detail of modelling and texture. 4) The video looks elegant but also dynamic under the changeable music rhythm. 5) Hundreds of objects make the scenes look magnificent.

**Weakness:** 1) Motion graphics is sort of too long if it is for an opening title sequence. 2) Stronger sense of rhythm if treat the tempo for each scene different not only follow the Itinerary graph. 3) the objects hope to look more paper-like, by maybe adding more of a paper texture in UV Mapping. 4) Great if the animation of unfolding paper is more detailed especially for the front piece for each object.

In summary, the video received good comments overall but numerous minor issues were pending to be modified. Mainly people, who have yet to visit China, indicated that my title sequence seemed interesting and also aroused their willingness of visiting Beijing. On the other hand, people who have already been to Beijing thought the video remind them of the fun memories in Beijing in the past and it was great to have seen many of the interest places of Beijing through my thesis.
4.2 THESIS SUMMARY

This project provided a variety of challenges, yet many educational opportunities for me to improve my skills, such as creating a title sequence with 3D animation. From storyboarding, modeling, texturing, animating, and rendering to compositing, I had to remain meticulous every step of the way. There are four conclusions that can be made and they are listed as follows:

1) Classification of Working Files

A final project normally generates a tremendous amount of working files, including PNG, and JPEG. It is of the utmost importance to classify the files in an organized fashion. At the beginning, I kept adding and dropping objects into one Maya file, which resulted in frequent software crashes. Even though I made backups, I still lost numerous files that had already been completed, and the repeated efforts became time consuming. As the project progressed, I learned to separate each scene into individual files to make the adjustment of frame and camera easier.

2) Precise Time Control

Time control was considered to be the most vital portion of this project. I had to consider the time of every single step and be as accurate as possible during the modeling phase. Working through the project timeline, I could simply ignore the fact that time would be wasted in terms of redoing, computer crashing, and other unforeseeable problems. Therefore, a time schedule must be made to allow more flexiblity in anticipating worst case scenarios that could happen along with way.
3) Planning (step by step)
Prior to beginning a project, it is important to provide a plan layout and remain well organized to avoid wasting any time. From personal experience, I actually started working on my first experiment without organization and planning and continued working like this for about three months. However, once I figured out a large flaw in my experiment, it ended up costing me many hours of valuable time. Ever since the final drawing lessons, I decided to plan out and work through each procedure step by step so that I could finish my thesis in a timely manner. Moreover, a detailed storyboard before beginning to develop the project could also offer a much clearer picture to the overall project.

4) Capability of Independent Thinking and Problem Solving
My logical capabilities vastly improved working on this thesis from start to finish, from everything in a spin at the beginning until everything became more under control later on. Although I did struggle and become confused when a massive problem occurred, I was able to sort out the problem by performing researches, watching tutorials, or consulting professors. I eventually developed a stronger, more positive mentality in terms of problem solving. I noticed that everything will smooth itself out in due course.

In conclusion, I believe that experience, especially hands-on experience, is a crucial component to be a successful 3D designer. This project has proven the concept of practice makes perfect, as this effort could not be completed with one attempt. I have gained a plethora of experiences from the constant trials and errors of the designing phase. In the end, I am now able to create the storyboard in a much more detailed fashion.
05/
BIBLIOGRAPHY
**Paper-Cutting**


**3D Animation**


Maya and Motion Graphics


APPENDIX: THESIS PROPOSAL
Title

China Special Series: Promoting the Internet Travel Program of Beijing with Motion Graphics

Situation Analysis

China is a country with a 5,000-year history. The mysteries and power of China is the main reason visitors are attracted to travel there from all over the world. While Beijing is the capital of China, it is also one of the biggest cultural centers in the world. It inhabits many of China’s most important cultural elements and traditions. Therefore, Beijing also represents China as a whole. Beijing gives tourists a compelling reason to visit because Beijing possesses characteristics of both China’s ancient history and modern China. Thus, a special series of an Internet travel program featuring Beijing is the primary and comprehensive stage to introduce China to the world. Audiences will want to watch a high-quality Internet travel channel with a stylish and informative title sequence. The main purpose of the business is to raise click rate and attract viewers’ eyes through a good title sequence. My thesis project aims to use a new computer graphic design technique to create and promote the original title sequences.

For the title sequence, I am designing a special series for a fictitious Internet travel program called “Hey! Beijing.” The famous ancient architecture and traditional culture will be the base of Chinese traditional paper-cutting that I will create with motion graphics, animation design, and 3D modeling. Traditional paper-cutting in China is an art of cutting paper designs into various shapes and patterns. Thus, the title sequence will have a moving pop-up book theme with which to promote Beijing.
Problem Statement

In the past, travel documentaries on television were the main marketing method to show the audience about one city. As time has changed, we are moving towards a more electronic / digital media dominated era. The traditional ways of title sequences for a travel program in China is to use the techniques of 2D photographs and documentaries, which might seem a little unattractive in this information world. For a modern society, people are looking for something new and more interesting to attract their eyes and to catch the first impression. In order to improve the visual style, I believe motion graphics can achieve it. That is why I design this title sequence as my thesis project.

Purpose of Thesis

The purpose of this project is to explore new media design and to use motion graphics to promote Beijing’s tourism. This project utilizes modern computerized tools as well as traditional art to create an informative, yet more importantly interesting, piece of work to promote this world’s infamous city of Beijing in an innovative way.

First, traveling has always been one of my great interests. I have always wanted to travel to countries with different cultural and historical backgrounds. Ever since studying abroad in the United States, I like to share my culture and other traditions with my newfound friends. Most of my foreign friends wish to travel to China. However, the travelling fee might be pricey. Thus I am trying to share the experience with all friends in a more state-of-the-art yet inexpensive way. As a result, I have come to the conclusion to create a high-quality title sequence for an Internet travel program of China through Beijing to publicize past Chinese
Second, as an international student who is studying 2D, 3D, and motion graphics in U.S., I have had many opportunities to watch excellent motion pieces and learn advanced techniques to create them. Furthermore, I want to use this opportunity to practice my skills and prepare for job hunting in this field in the future. Overall, my purpose is to excite viewers about traditional Chinese culture by utilizing my skills through the use of an Internet travel program title sequence.

**Survey of Literature**

During one month of research, I found many useful resources regarding traditional and classical elements of the city—Beijing—and even the country—China. I also found numerous successful examples from the motion graphics field. All related information has offered me direction and inspiration for promoting this special series of title sequencing. Moreover, other related technique books will assist me in completing this project. As a consequence, I then chose my main survey fields to focus on Chinese traditional design elements, motion styles, and software.
The Field of Content and Style

1) Books

Travel Around China: The Guide to Exploring the Sites, the Cities, the Provinces, and More
by Blue Sky Publishing Staff, Published by HarperCollins Publishers (September 01, 2008)

Travel Around China provides an overview of tourism in the whole of China, from Beijing to the Great Wall as well as other infamous tourist must-sees and beyond. It lavishly illustrates China’s highlights with hundreds of color pictures. From this book, I have a better understanding of what a tourist would like to see and experience, unlike the usual concentration and highlights. Thus, I can create more fun and interesting elements (architectures, cultures, etc.) in my title sequence in order to better attract an audience.

Chinese Architecture
by Nancy Shatzman Steinhardt, Published by Yale University Press (December 01, 2002)

This book is a comprehensive and authoritative study of Chinese architecture from Neolithic times to the late 19th century. It describes the story and pictures of China’s architectural achievements, the forms they took, and the historical, political, cultural, and social factors that shaped them. This book provides me more in-depth evidence and explanation of traditional architecture in my the Culture Section of the title sequence.
Chinese Paper-Cuts
by Sun Bingshan, Published by China Intercontinental Press; 1st edition (2007)

This book introduces making creative, colorful paper cuts for decorations and forms of various artistic styles. Paper cutting has a long history, as early as thousands of years ago. As the tradition is still being carried on today, I choose to add such element to boast and even to attract all audiences. Such decoration beautifies and makes the entire sequencing more unique than usual. Therefore, this book has offered me a lot of good examples and inspiration for paper-cuts design.

Chinese Houses: A Pictorial Tour of China’s Traditional Dwellings
by Congzhou Chen, Published by Betterlink Press Incorporated (February 05, 2009)

This guidebook of Chinese residential architecture introduces a selection of Chinese houses from every region of the country in photographs and illustrations. Also, this book covers the main traditional architecture styles of China, with a special focus on the residences of ethnic minorities. Therefore, it provides many archetypes of Chinese traditional architectures for me to create my own style 2D residence dwellings in City Section.
New China Architecture
by Xing Ruan, Published by Tuttle Publishing (March 15, 2006)

The spectacular transformation of China in the last decade is symbolized by its architecture. China’s new wealth and the invasion of Western culture have created a dynamic environment for architecture. The book documents the stunning designs of famed international architects and local Chinese architecture. It provides me with several good examples of famed modern architectures in my City Section of the title sequence.

2) Websites

http://motionographer.com/

It is a great communication stage for motion designers to share innovative ideas and techniques. From this website, I admire a lot of spectacular and successful pieces of motion graphics, which provide insights and sparkle to my ideas to promote my title sequence.

http://superfad.com/

This is a brand-driven design and live-action production company. This company was founded in 2001 and has produced award-winning work for many of the most respected brands worldwide. Its work is informed by a wide array of cultural and intellectual influences. Thus, the motion graphics of Superfad could be another good resource to enhance my title sequence’s quality.
http://superfad.com/work/campaign/cox_my_prime_time

A series of paper-folding title sequences, which Superfad used to make for Cox & Company, Inc., gives me some ideas about how to improve the paper-cuts sections.

http://vimeo.com/channels/67615

This section in Vimeo demonstrates a similar perspective in terms of promoting travel. This video uses motion graphics for a traveling title sequence that can give me some inspiration.

http://www.vimeo.com/11214842

Travel Journals
by Stephen Ong (Designer)

This independent designer has created a series of amazing title sequences and posted them on Vimeo. The special drawing skill of this 2D animation gives me some inspiration to design the 2D section.
3) The Field of Design

Mastering Maya 2009
by Micheal Ingrassia, Published by Focal Press (October, 2008)

This advance Maya handbook covers all aspects of Maya from modeling, animation, texturing, and visual effects to high-level techniques for film, television, and games. It is related to the techniques that I am going to use in the 3D part of the title sequence. This book definitely serves as one of the useful tools while developing the Maya file.

Flash+After Effect: Add Broadcast Features to Your Flash Designs
by Chris Jackson, Published by Elsevier Science & Technology Books (August 11, 2010)

This book summarizes the technique of integration of Adobe Flash and After Effects. It would be extremely important to integrate these softwares into the process of creating my motion piece.

Advanced Maya Texturing and Lighting
by Lee Lanier, Published by Sybex; 2 edition (August 11, 2008)

It includes extensive and updated coverage of particle texturing, pelt mapping, Global Illumination, Final Gather, HDR lighting, mental ray shaders, normal mapping, and multipass rendering. I can better utilize the technique while creating my piece, as the latest information on texturing and lighting are included for reference if necessary.
Project Description

2D, 3D and Motion Graphic Design

In terms of all motion graphic design aspects of this project, I will utilize numerous powerful computerized tools, such as Adobe Flash, Illustration, Maya, and After Effects, in order to compose all of the visual elements in the creation of a motion graphic piece and a logo to promote the program.

Title Sequence

In this video, I will create three main actions to show the transition between old Beijing and modern Beijing in the form of paper-cutting shapes. There will be a transition using a moving pop-up book style to flow from element to element (i.e., unfolding pages). For the old Beijing part, which is considered the main action one, I will create some representative traditional Chinese elements that Beijing possesses. Although I will mainly focus on Beijing’s famous architectures (such as the Great Wall and Forbidden City), other surroundings, such as traditional dress, the decorations used for celebrating Chinese festivals (such as fireworks and the lucky symbol), Kung Fu, pandas, Chinese Zodiac, Peking opera make-up, Chinese knots, and Beijing foods or snacks, are all included in the first part as well. For the transition part, which is main action two, I will use the classical architecture styles for residential housing in old Beijing (such as Hu Tong), serving as a time tunnel to connect the old Beijing part and modern Beijing part. As for the modern Beijing part, which is main action three, I will mainly use some representative modern architecture to represent new Beijing (such as New CCTV building, Bird Nest, National Grand Theater, Water Cube, and Airport). In addition, transportation (such as subway and taxi), crossroads, a famous shopping mall,
and museums are also included to strengthen the modernized view. I will mainly use Maya to animate the unfolding pages, to design the shape of paper-cutting elements in 2D (Illustration), and then to model it in Maya. Moreover, I will use 2D methods to animate some visual elements to enhance the effects of each action (such as clouds, the traditional life of Beijing citizens in Hu Tong, buildings). Then I will edit it in After Effects and add more visual effects.

Logo Design

I will develop a brand using a 2D logo for the Beijing special series of the fictitious Internet travel program, which will be called Hey! Beijing.
Storyboard

Fig. 35A Storyboard
Fig. 35B Storyboard